
NetDoc Help Index
The Index lists Help topics available for NetDoc. Use the scroll bar to see entries not currently visible in 
the Help window.

To learn how to use Help, press F1 or choose Using Help from the Help menu.

Commands
File Menu
Edit Menu
View Menu
Object Menu
Locate Menu
Describe Menu
Reports Menu

How to...
Copy an object
Create an object
Delete an object
Draw a link
Draw a ring
Highlight a link or ring
Modify an object
Order NetDoc

Other...
Disclaimer



File Menu

The File menu includes commands that enable you to open and save files, establish a new workspace, 
and to print.

For more information, select the File menu command name.

New
Open
Save
Save As
Print
Printer Setup
Order Form
Codeword
Exit



Edit Menu

The Edit menu includes commands that enable you to move bitmaps to and from the clipboard.

For more information, select the Edit menu command name.

Copy Bitmap
Paste Bitmap
Copy Bitmap To
Paste Bitmap From



 View Menu

View(s) make up a network map, which can be thought of as an inverted tree structure.    By double-
clicking on subnet icons you drill down to more detail on the network.    By using the View Menu you can 
create new or modify current Views of your network.

For more information, select the View menu command name.

View Previous
View Go to
View Jump to Top
View Set Top View



Object Menu

The Object menu includes commands that enable you to create, modify, move, copy, and delete Objects. 
Objects include lines, circles, Element and pointers to other Views.

For more information, select the Object command name.

New
Open
Move
Copy
Delete
Properties



Locate

The Locate menu item allows you to find Views, Elements or Descriptions in the data base for quick, easy 
access to your data.

Click on the Locate menu item.

A dialog box will be displayed.    Choose the Field Name that you would like to search on.    Click the 
down-arrow for a list of choices, then click on the your selection.    For example choose User Name if you 
would like to search for one of your users and you know the name of that user.

Once you select a Field Name, a list of possible matches will appear under the Equals box.    Click the up-
arrow or down-arrow to display the selections.    Click on your selection and it will appear in the Equals 
box.

Click on the Search Database button.

A search will occur and display the results in the Search Results box.    You may click the Go To Object... 
button to automatically bring you to the found object.    You may also click on the Close button to close the 
Locate dialog box and find the item yourself using the new found information.



Describe Menu

Describe is an interface to information about a particular object on the network.    There are seven 
categories of information that you can record about each object: Status, Asset data, Location, Supplier, 
Support, User, and Other.    Note that only Elements, Links, Rings, and Text items can be Described; View 
icons cannot.

Click once on the object that you would like to Describe (or read the description of).    The label of the 
object will be highlighted.

Click the Describe menu. Click one of the following menu items to add, modify or delete information about 
the highlighted Element:

Status
Asset
Location
Supplier
Support
User
Other



Reports Menu

The Reports Menu allows you to set up and run reports against the information that you have entered 
about your network.    You may also run pre-defined reports.

Query
Status
Asset
Location
Supplier
Support
User



File New

The New command starts a new file to create a new network.

After you choose this command, NetDoc asks if you want to save the current network file (if any).    Click 
on the appropriate button (YES, NO or CANCEL).    Then NetDoc clears the current network map from 
your screen and displays an empty window.



File Open

The Open command opens an existing file that contains a network map that you created earlier.

NetDoc may ask if you want to save the current network file (if any).    Click on the appropriate button 
(YES, NO or CANCEL).

A dialog box then prompts you to either choose a title from the list box or type the title of the network you 
want.    Network files have the extension of .TVM.

Choose a network file, click OK and NetDoc will display the network on your screen.



File Save
The Save command saves the changes you've made to the current network map and data, under the 
existing filename.

After you choose this command, a dialog box prompts you for a name, if the file is untitled.    If    you have 
already named the file, NetDoc overwrites the network map under that previously specified file name.    
Network files have the extension of .TVM.



File Save As
The Save As command saves a new network map, or saves the changes you've made to the current 
network map    under a new name.

After you choose this command, a dialog box prompts you to type a name for the current network map. 
NetDoc then stores the network map in file under the name you specified.    Network files have the 
extension of .TVM.



File Print

The Print command prints the currently displayed network map and its objects to your printer.    After you 
choose this command, a dialog box tells you that NetDoc is sending your View to Spooler. If you want to 
stop printing your View, choose the Cancel button.

This command is inactive if you have not set up a printer using the Setup program or Control Panel.    See 
the Microsoft Windows User's Guide    for information about adding and setting up printers.



File Printer Setup

Selects a printer and sets printer options for NetDoc before printing. The available options depend on the 
printer you select. 

To change printers
1. Choose File Printer Setup.
2. Select the printer you want to use.
3. Choose OK.



File Order Form

The Order Form menu item will display an online registration form for ordering NetDoc.    Fill in the order 
form as completely as possible by using TAB key or click the mouse to move to the next box.    Point and 
Click within the circle for the Method of Payment.    If a Credit card is chosen, fill in the number, Expiration 
Date and card holder name completely and as it appears on your credit card.

Under Ordering Information, simply click in the Units box and type the number of software licences that 
you want.    One license is required per Personal Computer running NetDoc.    The order form will 
automatically total the amount for you.    Click the Send order to Notepad for printing button to print or to 
send via fax/modem.    If you would like to order by phone, please have all the information that is on the 
order form ready.    You may order via TeraVision's voicemail system as well.    Simply give all the 
information on the order form slowly and clearly, including the System ID Number.    Spell and repeat all 
items clearly to avoid delay of licensing.

Every Personal Computer has its own unique codeword.    Therefore, one license that you receive is valid 
for one PC and only your specific PC.    If you move the NetDoc software to another PC, your codeword 
will not work on that PC and NetDoc will be unlicensed.



File Codeword

The TeraVision's menu item allows you enter the codeword into the system once you have purchased the 
license to use.    Point and click in the box and you will see a flashing cursor bar.    Type in the codeword 
exactly as you see it on the license and click on OK.    This will register your software.

Note that after an extended period of time of using an unlicensed version of NetDoc, the Codeword 
screen will appear TeraVision's, to remind the user that shareware is not free and must be paid for if 
continued to be used.

Every Personal Computer has its own unique codeword.    Therefore, one license that you receive is valid 
for one PC and only your specific PC.    If you move the NetDoc software to another PC, your codeword 
will not work on that PC and NetDoc will be unlicensed.



File Exit

The Exit command ends your NetDoc session.    NetDoc will ask you whether you want to save the 
changes (if any) that you have made.    If you chose yes, your changes will be saved in the file currently 
opened.    If you chose no, then no changes that you made this session will be saved, keeping the file the 
way it was when you opened it.    If you chose cancel, you will be placed back into NetDoc and not exit.



Edit Copy Bitmap 

The Copy Bitmap menu item is used to copy the currently displayed network map to the Clipboard (See 
the Microsoft Windows User's Guide for information about Clipboard) for pasting later.    Clipboard is a 
convenient place to hold your map while finding another view.



Edit Paste Bitmap 

Paste Bitmap will take whatever you have stored in the Clipboard and paste it to the screen that you are 
currently on.



Edit Copy Bitmap To 

The Copy Bitmap To... menu item is used to save a copy of the currently displayed network map into a 
bitmap file.    When you chose this, select if you wish to save the bitmap and objects the way they appear 
or just the bitmap with no objects.    Then a screen will be displayed to allow you to choose a file name for 
your bitmap.

Caution:    When you copy a bitmap and its objects to a file, the objects that appear in that new file will 
only be bitmap images of the objects.    The objects that appear on the new bitmap are actually now part 
of the bitmap, and therefore cannot be moved, manipulated or deleted like objects.



Edit Paste Bitmap From 

The Paste Bitmap From... command is used to paste onto the current screen a bitmap that has been 
saved in a file.



View Previous 

The Previous menu item allows you return to the previous View .    If you click again you will move one 
View closer to the top View.    You can repeat this process until you have reached the top View.



View Go to 

The Go to... menu item allows you to go to any existing network screen View.    Click on the down arrow 
button for a choice of View Names in this network map.    Click on the desired View Name and it will 
highlight.    Click OK and you will go to the chosen screen.    If you go to another screen, NetDoc closes 
the current screen.



View Jump to Top 

The Jump to Top menu item allows you to jump to the top View from anywhere in the network.    The top 
View is the broadest view of your network and is defined with Set Top View.



View Set Top View 

Set Top View... enables you to specify the View you want presented when you open the network map file. 
This Top View should be the broadest area that you want to see in your network (such as world wide, or 
city wide).

Any View under the Top View is called a Subnet View.    Subnet Views can contain object icons for 
elements    or can contain object icons for more Subnet Views. 



Object New

The New menu item allows you to create a new object icon to be added to your screen.    You can choose 
from 5 different object types:

1. View - Creates an object icon which represents another view to drill down to (for example, if you have 
the world map displayed, you can create a View object to represent North America).

2. Element - Creates an object icon which represents a system, personal computer, printer, hub, router, or 
any other element that may be on your network.

3. Link - Creates an object in the shape of a line to represent network connections between cities or 
systems.

4. Ring - Creates an object in the shape of a circle to represent a ring type topology connection between 
systems (such as a Token Ring).

5. Text - Creates an object to label your View (such as the city's name).

Click on the object type that you desire and click OK.

If you choose View or Element:

A dialog box will appear.    Type in the Name of the object icon.    Name is a unique identifier of the 
View or Element and is a required field.

Then click on the up/down arrows to display and choose different icons. 

Click OK.    The object will appear in the upper left corner of the current View.    Drag the selected 
object with the mouse until it is positioned where you want it.    Release the mouse button to set the new 

position.

If you choose Link or Ring:

Your mouse will turn into a crosshair.

Move the mouse to where the you want to start your link/ring.

Click and hold down as you drag the crosshair to where you want the drawing to end.

Release the mouse button when you reach the end.

If you choose Text, simply type in the text that you want to annotate this network View.



Object Open 

The Open menu item opens the activated object on the screen (if any).    If a View object is activated (the 
label is highlighted), then that View will appear.    If an Element object is activated, then status information 
will appear.    You can also open an object simply by double-clicking on the object.



Object Move

The Move menu item allows you to move an object to another View.    Click on the down arrow button of 
the "TO View" list box for a choice of View Names in this network map.    Click on the desired View Name 
and it will become highlighted.    Click OK and the object that was highlighted will be moved to the new 
View and deleted from the current View 



Object Copy

The Copy... menu item allows you to copy an object to another View.    Click on the down arrow button of 
the "TO View" list box for a choice of View Names in this network map.    Click on the desired View Name 
and it will become highlighted.        Click OK and the object that was highlighted will be copied to the new 
View and a copy will also remain in the current View 



Object Delete

The Delete menu item will delete the highlighted object.    A dialog box will appear to ask you if you want 
to delete the highlighted object.    Click OK if you want to delete, or click cancel if you do not want to 
delete the object.



Object Properties

The Properties menu item allows you to display and/or edit the properties of the highlighted object. 
Pressing the right mouse button on any object will also allow you to display and/or edit the properties of 
the highlighted object.



Describe Status

Click on the Status menu item, and a dialog box will appear for you to input information regarding the 
status and problem for the highlighted element.

First, enter the object status.    Click the down arrow key and select one of the Status options.    In 
choosing one of the status options, you will change the color of the object to a different color, so you can 
tell the general status of an element just by looking at it from the graphical view.    The colors will be 
reflected all the way up the tree structure, so you know where to drill down to the specific component that 
may be having problems.    The table below shows the status and colors that the objects will change to 
when the status is chosen:

 - Non operational Red
 - Partially operational Yellow
 - Update requested Purple
 - Fully operational Green
 - Unknown None

Next, fill in the information regarding the Problem, Contact Information, and Progress Resolution Status. 

Click OK when you have filled out as much information as needed.

The Copy button will copy the current dialog box information to memory.

Use the Paste button to paste the information that is in memory into the dialog box window.    (You must 
have previously Copied something into memory from another dialog box).

The Send Page button can be used to send a page to a support person with the information that you have 
typed in about the object.
NOTE:    This feature requires additional software not included in NetDoc.    You must order the Pager 
Module program separately as well as have an installed modem.



Describe Asset

Click on the Asset menu item, and a dialog box will appear for you to input information regarding that 
Asset.

Input the Type of asset the icon represents.    For example, Unix Server, or PC client.    Click, the down 
arrow button for a list of choices for Type of assets, or simply key in a new Type of asset.

Next, input a description of the asset.    For example, the brand name and the model of the asset.

Now you can input details about components within the asset, such as I/O cards, software or printer 
cartridges, etc.    Click the Add button to add a new component.    Click the Modify button to modify the 
highlighted component in the component list that you have previously entered.    You may also simply 
double click on the component. in the component list.    The Edit dialog box will appear.

Enter the Type of the component (for example Hardware or Software).    Click the down arrow button for 
choices or simply key in a new Type for the component.

Fill in the blank spaces giving as much detail as possible.    Move from box to box by either clicking with 
the mouse or by using the tab key.    Enter the Manufacturer, Model, Serial Number, Asset Number, Asset 
of Entity, a Description of the component, the Purchase Price and the Current Value.    If the Current Value 
is the same as the Purchase price, simply click on the > button to quick-copy the Purchase Price value in 
the Current Value box.

If you have many assets that are similar in description, NetDoc makes it easy to copy and paste those 
descriptions.

The Copy button will copy the current dialog box information to memory. 

Use the Paste button to paste the information that is in memory.    (You must have previously Copied 
something into memory).

Use the Paste From... button when you know that this asset looks very similar to another asset.    A dialog 
box will appear and allow you to choose a component asset to paste into the current window.    Use the 
scroll bar on the right to see more choices.    Click on the component asset that you want, and it will be 
pasted into the component dialog box.    This command keeps the original copy in tact.

Use the Move From... button to the same as the Paste From... button (above), except this will erase the 
original copy and move it to the current dialog box displayed.    Use caution when using this command.

When finished adding or modifying information, click on OK button.    If a new component was added, you 
will now see that component in the component list.    You may add another component now by clicking the 
Add button and repeating the above steps, or you may Close the dialog box by clicking on the Close 
button.



Describe Location

Click on the Location menu item, and a dialog box will appear for you to input information regarding the 
asset's location.    Fill in the blank spaces giving as much detail as possible.    Move from box to box by 
either clicking with the mouse or by using the tab key.    Enter the Cable Drop Number, Area (such as Lab, 
Marketing, etc.), Floor/Suite, Building, Street, City, State/Province, and Country. 

The Copy button will copy the current dialog box information to memory. 

Use the Paste button to paste the information that is in memory.    (You must have previously Copied 
something into memory).

If you have other information to record, click the Other button.    A dialog box will appear with many places 
to enter additional information.    To label the field, click on the Define button, and type in the label name of 
the field, then click OK.

When finished entering the location information, click OK to return to the map.



Describe Supplier

Click on the Supplier menu item, and a dialog box will appear for you to input information regarding the 
Element's supplier.    Fill in the blank spaces giving as much detail as possible.    Move from box to box by 
either clicking with the mouse or by using the tab key.    Enter the Customer ID Number, Supplier's Name, 
Beeper number, Phone Number, Fax Number, and complete Address. 

The Copy button will copy the current dialog box information to memory. 

Use the Paste button to paste the information that is in memory.    (You must have previously Copied 
something into memory).

If you have other information to record, click the Other button.    A dialog box will appear with many places 
to enter additional information.    To label the field, click on the Define button, and type in the label name of 
the field, then click OK.

When finished entering the Supplier information, click OK to return to the map.



Describe Support

Click on the Support menu item, and a dialog box will appear for you to input information regarding 
support for the Element.    Fill in the blank spaces giving as much detail as possible.    Move from box to 
box by either clicking with the mouse or by using the tab key.    Enter the Customer ID Number, Contract 
Number, Contract Expiration date, Price per Month, Contact Name, Beeper, Phone, Fax and complete 
Address of the Support supplier.

The Copy button will copy the current dialog box information to memory. 

Use the Paste button to paste the information that is in memory.    (You must have previously Copied 
something into memory).

If you have other information to record, click the Other button.    A dialog box will appear with many places 
to enter additional information.    To label the field, click on the Define button, and type in the label name of 
the field, then click OK.

When finished entering the support information, click OK to return to the map.



Describe User

Click on the User menu item, and a dialog box will appear for you to input information regarding the 
Element's user.    Fill in the blank spaces giving as much detail as possible.    Move from box to box by 
either clicking with the mouse or by using the tab key.    Enter the User's Name, Title, Login, Phone, Fax, 
X.500 Address (if any), Employee number, Department, Manager's Name and phone, and the mailing 
address of the User.

The Copy button will copy the current dialog box information to memory. 

Use the Paste button to paste the information that is in memory.    (You must have previously Copied 
something into memory).

If you have other information to record, click the Other button.    A dialog box will appear with many places 
to enter additional information.    To label the field, click on the Define button, and type in the label name of 
the field, then click OK.

When finished entering the user information, click OK to return to the map.



Describe Other

Click on the Other menu item, and a dialog box will appear for you to input other important information 
regarding the Element that is not defined in any other dialog box.    Fill in the blank spaces giving as much 
detail as possible.    Move from box to box by either clicking with the mouse or by using the tab key.

To label the field, click on the Define button, and type in the label name of the field, then click OK.

The Copy button will copy the current dialog box information to memory. 

Use the Paste button to paste the information that is in memory.    (You must have previously Copied 
something into memory).

When finished entering other information, click OK to return to the map.



Reports Query

The Query menu item allows you to define and print your own report.

Click on the Query menu item to display the query dialog box.

Choose the Field that you would like to query.    Click on the down-arrow button for a list of choices.    You 
may choose User, Supplier, object name or a multitude of other fields to query.

Next choose the Operator.    This will allow you to compare/contrast the Field with the Value (chosen 
next).    Click on the down-arrow button for a list of choices.    For example, equals.

Next choose the Value.    A list of appropriate choices will be displayed in the Value List.    This list will 
contain values that you have entered for the Field choice that you made above.    Click on the Value in the 
Value list that you want to query.

Now select the output fields that you would like to have displayed in your report.    In the Select Output 
Parameters box, double-click your choices from the Select from list and you will see it displayed in the 
Report on list.    Continue this until all the Parameters that you want are displayed in the Report on list.

If you want all Parameters in your output, click on the >> button. 

If you want just the highlighted choice in the Select from list to be displayed in the Report on list, click on 
the > button.    This can also be accomplished by double-clicking on a choice in the Select from list.

If you want to remove a choice from the Report on list, click to highlight your selection in the Report on 
list, then click on the < button.

If you want to remove all choices from the Report on list (to start over for instance), click on the << button.

The width of the character field is displayed in the Report on list.    To change the width of a particular 
field, double-click on the field in the Report on list.    A dialog box will appear to allow your to choose the 
width.

To Query the database, simply click on the Query Database... button.    A dialog box will appear to ask you 
where to send the output.    Click on the circle near your choice of MS Notepad, MS Write, MS Excel, 
Lotus 123, or other.    Also, select the format of how you would like the data delimited (how the fields are 
separated).    To send the output, click on the Send Report to______ button (where the blank will be the 
destination).



Reports Status

The Status menu item allows you access to a canned report of the Status of Elements on the network.    
The Query dialog box will appear with all Elements chosen.    You may change this report by following the 
Query instructions or simply accept the report by clicking on the Query Database... button.



Reports Asset

The Asset menu item allows you access to a canned report of all the Elements on the network.    The 
Query dialog box will appear with all Elements chosen.    You may change this report by following the 
Query instructions or simply accept the report by clicking on the Query Database... button.



Reports Location

The Location menu item allows you access to a canned report of all the locations on the network.    The 
Query dialog box will appear with all Location information chosen.    You may change this report by 
following the Query instructions or simply accept the report by clicking on the Query Database... button.



Reports Supplier

The Supplier menu item allows you access to a canned report of all the suppliers on the network.    The 
Query dialog box will appear with all Supplier information chosen.    You may change this report by 
following the Query instructions or simply accept the report by clicking on the Query Database... button.



Reports Support

The Support menu item allows you access to a canned report of all the support on the network.    The 
Query dialog box will appear with all Support information chosen.    You may change this report by 
following the Query instructions or simply accept the report by clicking on the Query Database... button.



Reports User

The User menu item allows you access to a canned report of all the users on the network.    The Query 
dialog box will appear with all User information chosen.    You may change this report by following the 
Query instructions or simply accept the report by clicking on the Query Database... button.



XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
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Overview
NetDoc for Windows --    NetDoc, designed for network documentation, allows network managers to 
establish a complete graphical interface and database of LANs and WANs. NetDoc provides the ability to 
view your entire network across countries, states, cities, buildings and offices. Drill down through the 
hierarchical views to any element on your network. Easily track detailed network Element information 
including asset numbers, serial numbers, locations, users, support agreements, as well as user definable 
information. Problems can also be tracked and managed through NetDoc. To respond as problems arise 
you can quickly dispatch support technicians through NetDoc's alphanumeric pager support. When 
tracking problems, network node status can be set and displayed visually, with color coded icons.    Over 
30 colorful network specific icons graphically identify the elements of your network including PCs, servers, 
hubs, routers, etc. 



How To Register NetDoc

If you would like to order NetDoc, please fill out the online order form and send it to:

TeraVision, Inc.
785 Virginia Avenue 
Campbell CA 95008 
USA

Phone: (408) 378-9328
FAX: (408) 378-9374

We will send you a codeword and License-To-Use authorizing you to continue using NetDoc. We can also 
inform you of new versions and enhancements. 

For more information, select one of the following commands ... 
Order Form
Codeword



How to draw a link

Draw a link

To draw a link

1 Select menu item Object and New 
2 Select the Link tool. 
3 Move the cursor into the drawing area. 
4 Press the mouse button to anchor one end of the line, and then drag the cursor. A flexible line 
stretches from the anchor point to the mouse position. 
5 When you are satisfied with the line, release the mouse button. 



How to draw a ring

Draw a ring

To draw a ring

1 Select menu item Object and New 
2 Select the Ring tool. 
3 Move the cursor into the drawing area. 
4 Press the mouse button to anchor one end of the line, and then drag the cursor. A flexible circle 
stretches from the anchor point to the mouse position. 
5 When you are satisfied with the ring, release the mouse button. 



How to highlight a link or ring

Highlight a drawing

To highlight a drawing

1 Click on the center of the link or ring.
2 The line or ring will turn blue when activated. 



 



Disclaimer 
LIMITED LIABILITY - IN NO EVENT WILL TERAVISION, INC.    BE LIABLE TO YOU FOR ANY 
DAMAGES, INCLUDING ANY    LOST PROFITS, LOST SAVINGS OR OTHER    INCIDENTAL OR 
CONSEQUENTIAL DAMAGES EVEN IF    TERAVISION, INC. OR ANY TERAVISION, INC. 
REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF    SUCH DAMAGES, OR FOR ANY 
CLAIM BY ANY OTHER PARTY. 





 



Context Sensitive Topics

 To get context-sensitive help from Helpex, press Shift+F1 and click on any element of the application window. You 
can also highlight any Helpex menu command using the keyboard and press F1 to get help on the command. Each 
topic has a unique context identifier, listed in the [MAP] section of the Help project file:

[MAP]
#define HELPID_EDIT_CLEAR          100
#define HELPID_EDIT_COPY            101
#define HELPID_EDIT_CUT              102
#define HELPID_EDIT_PASTE          103
#define HELPID_EDIT_UNDO            104
#define HELPID_FILE_NEW 201
#define HELPID_FILE_OPEN 202
#define HELPID_FILE_PRINT 203
#define HELPID_FILE_SAVE 204
#define HELPID_FILE_SAVE_AS 205
#define HELPID_FILE_PRINT 207
#define HELPID_FILE_PSETUP 209
#define HELPID_FILE_ORDER 211
#define HELPID_FILE_CW 213
#define HELPID_FILE_EXIT 220
#define HELPID_EDIT_WINDOW        300
#define HELPID_MAXIMIZE_ICON    301
#define HELPID_MINIMIZE_ICON    302
#define HELPID_SYSTEM_MENU        305
#define HELPID_TITLE_BAR            306
#define HELPID_SIZING_BORDER    307
#define HELPID_EDIT_COPYTO    308
#define HELPID_EDIT_COPYBITMAP 310
#define HELPID_EDIT_PASTEBITMAP 312
#define HELPID_EDIT_COPYBITMAPTO 314
#define HELPID_EDIT_PASTEBITMAPFROM 316
#define HELPID_VIEW_PREVIOUS 320
#define HELPID_VIEW_GOTO 322
#define HELPID_VIEW_JUMP_TO_TOP 324
#define HELPID_VIEW_SET_TOP_VIEW 326
#define HELPID_OBJECT_NEW 330
#define HELPID_OBJECT_OPEN 332
#define HELPID_OBJECT_MOVE 334
#define HELPID_OBJECT_COPY 336
#define HELPID_OBJECT_DELETE 338
#define HELPID_OBJECT_PROPERTIES 340
#define HELPID_DCB_PROBLEM 350
#define HELPID_DCB_ASSET 352
#define HELPID_DCB_LOCATION 354
#define HELPID_DCB_SUPPLIER 356
#define HELPID_DCB_SUPPORT 358
#define HELPID_DCB_USER 360
#define HELPID_DCB_OTHER 362
#define HELPID_REP_QUERY 370
#define HELPID_REP_STATUS 371
#define HELPID_REP_ASSET 372
#define HELPID_REP_LOCATION 374
#define HELPID_REP_SUPPLIER 376



#define HELPID_REP_SUPPORT 377
#define HELPID_REP_USER 378
#define HELPID_PROC_OVERVIEW 400
#define HID_HT_ORDER 402
#define HID_HT_DRAWLINK 404
#define HID_HT_DRAWRING 406
#define HID_HT_HILDRAW 420





Windows Keys

The keyboard topics below come from Help for Windows. You can create similar keyboard topics for your 
application's Help. Choose from the following list to review the keys used in Windows:

Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.

End or Ctrl+Right Arrow Moves to the end of a field.

Home or CTRL+Left Arrow Moves to the beginning of a field.

PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

TAB Moves from field to field (left to right and top to bottom).

SHIFT+TAB Moves from field to field in reverse order.

ALT+letter Moves to the option or group whose underlined letter matches the one you type.

DIRECTION key Moves from option to option within a group of options.

ENTER Executes a command button.

Or, chooses the selected item in a list box and executes the command.

ESC Closes a dialog box without completing the command. (Same as Cancel)

ALT+DOWN ARROW Opens a drop-down list box.

ALT+UP or DOWN ARROW Selects item in a drop-down list box.

SPACEBAR Cancels a selection in a list box.

Selects or clears a check box.

CTRL+SLASH Selects all the items in a list box.

CTRL+BACKSLASH Cancels all selections except the current selection.

SHIFT+ DIRECTION key Extends selection in a text box.

SHIFT+ HOME Extends selection to first character in a text box.

SHIFT+ END Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.

Or, deletes selected text.

Delete Deletes the character to the right of the cursor.

Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the Help window is 
already open, pressing F1 displays the "Using Windows Help" topics.

In some Windows applications, pressing F1 displays a Help topic on the selected 
command, dialog box option, or system message.

SHIFT+F1 Changes the pointer to  so you can get Help on a specific command, screen 
region, or key. You can then choose a command, click the screen region, or press 
a key or key combination you want to know more about.

(This feature is not available in all Windows applications.)



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.

Letter key Chooses the menu, or menu item, whose underlined letter matches the one you 
type.

Alt+letter key Pulls down the menu whose underlined letter matches the one you type.

LEFT or RIGHT ARROW Moves among menus.

UP or DOWN ARROW Moves among menu items.

Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are using.

Key(s) Function

Ctrl+Esc Switches to the Task List.

Alt+Esc Switches to the next application window or minimized icon, including full-
screen programs.

Alt+TAB Switches to the next application window, restoring applications that are running 
as icons.

Alt+PrtSc Copies the entire screen to Clipboard.

Ctrl+F4 Closes the active window.

F1 Gets Help and displays the Help Index for the application. (See Help Keys)



Text Selection Keys

Key(s) Function

SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left or right.

SHIFT+DOWN or UP Selects one line of text up or down.

SHIFT+END Selects text to the end of the line.

SHIFT+HOME Selects text to the beginning of the line.

SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is already 
selected.

SHIFT+PAGE UP Selects text up one window.

Or, cancels the selection if the previous window is already 
selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.

CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or end (DOWN 
ARROW) of the paragraph.

CTRL+SHIFT+END Selects text to the end of the document.

CTRL+SHIFT+HOME Selects text to the beginning of the document.



Window Keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.

ALT+Hyphen Opens the Control menu for a document window.

Alt+F4 Closes a window.

Alt+Esc Switches to the next application window or minimized icon, including full-
screen programs.

Alt+TAB Switches to the next application window, restoring applications that are running 
as icons.

Alt+ENTER Switches a non-Windows application between running in a window and running 
full screen.

DIRECTION key Moves a window when you have chosen Move from the Control menu.

Or, changes the size of a window when you have chosen Size from the Control 
menu.





Clipboard

This is a topic that describes the Windows term "clipboard". If you click the "clipboard" term within the Copying 
Text or Glossary topic, this Help topic will be displayed in a pop-up window.

This topic is also tagged with the keyword "clipboard," for use with the WinHelp Search option.



 


